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Foreword 
  
Thank you for purchasing Navigator. We hope you will come to rely on Navigator as a powerful productivity and color 
control tool.  
 
The essential components are: 
 
Navigator Server 
Navigator Client  
Navigator RIP 
 
This manual explains how to install and use Navigator Server and Client.  For those who need to go deeper into 
configuration and customization, there are separate manuals available for the RIP and for the color management engine.  
 

  

Chapter 1 – About Navigator Server and Client 

 

1.1 Overview 

Navigator is a job management and color control system.  
 It comprises three components that work together.   It has two components that run on the computer connected to the 
printer.  These components are Navigator Server, and the Harlequin-based, Navigator RIP. The third component is the 
client.  The client may run on any networked computer.  Navigator Client provides a single, simple user interface from 
which users - from their own desktops - can monitor jobs through various production stages. Users can view, modify, 
delete, re-process, and color-correct their work without leaving their desks. 
 
By using Navigator, operators can track thousands of jobs from their Windows or Macintosh clients.  
 

1.2 Navigator Server 

The Server and the RIP run on a PC.  This requires Windows 7 or Windows 8.  No “Home Edition” versions of 
Microsoft’s operating systems are supported. 
 
Navigator Server handles system security (licensing) and requires a dongle to run. However, for trial purposes, Navigator 
can run without dongles for a limited time.  
 
Operation without a dongle  
Without a dongle Navigator operates as follows: 
For a 90-day trial period, a watermark system will function.  Output will be at full quality and speed but will have thin 
watermark squares printed every so often across a job.  Both the demonstration version and the full, production version are 
available from the same installer disk.  At the beginning of the installation simply choose whether you wish to install a 
production system or a demonstration system, as shown in the screen capture below. 
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Operation with a dongle 
The Server handles system security (with the exception of connected RIPs). Therefore, Client platforms do not need 
dongles. The Server will accept as many Client connections as are currently licensed.  
Upgrades to the system can be handled with license codes.  Upgrading to support additional Clients is a simple process of 
entering a security code into the Server to update the permissions. This Server upgrade menu is called “Product Features.”  
Contact your dealer to purchase additional permission codes. 
 

1.3 Navigator Clients 

Clients are available for Windows 7, Windows 8, OSX 10. 
 
The Client provides the regular user interface to the system, after completion of basic system configuration. Users may 
connect to the Server and, subject to their access privileges, create or modify workflows and manage jobs.  
 
The system saves the user’s work and job status so the user can connect via another Client on another computer and see 
their work as they would expect. 
 
Clients allow users to: 

 Create, modify or delete workflows. 

 See jobs in the system using a number of different views. 

 Review jobs that are held at various workflow stages. 

 Release, delete or re-submit jobs. 

 Soft proof jobs on screen before final output. 

 Correct RGB, CMYK and spot colors 
 



 

 
 

Chapter 2 – Server Installation 
 

2.1  Preparing for installation 

Make sure you have USB hardware keys (dongles), an installer disk, and a printer that has been set up with ink, paper, and 
electrical power.  Don’t plug the dongles in yet.  We will do that later, after we prepare our computer’s network and user 
account settings properly. 
 
To prepare Windows XP, Windows Vista, or Windows 7 for use with Navigator requires a few configuration changes be 
made before installing the software. 

2.2  Preparing for installation to Windows 

 
Simple File Sharing 
The default configuration upon installation of Windows is for “simple file sharing” to be enabled. Before continuing, it 
should be turned off. To do so, follow these steps: 
 

Simple File Sharing 

 
 

1. Open a window. 
2. From the Tools menu select Folder Options . . . 
3. In the Folder Options window, select the View tab. 
4. Scroll to the bottom of the “Advanced settings:” list. 
5. Turn off Use simple file sharing as shown in the figure on page 10. 
 
 
You are now ready to install Navigator 
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2.3 Preparing for installation on Windows Vista  

The following section explains how to prepare Windows Vista: 
  
Step 1. Make sure you are running under a windows user that is a member of the local “administrators” group.  Navigator  
requires administrative access to operate correctly.  
 
Step 2. Selecting the correct network type. The first time your computer is connected to a network, it will ask what type of 
network you are connecting to. For Navigator to have the ability to see and be seen on the network, you need to select the “Work 
network” setting. 

 
 
Step 3. Disable the “sharing wizard”. This can be done by going to control panels and selecting “Folder Options” 
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Once in the “Folder Options” dialogue select the “View” tab and scroll down to the “Use Sharing Wizard” selection, deselect the 
option, and click apply. 
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Step 4. Disable the User Account Control (UAC). This can be done by going control panels and selecting “User Accounts”. 

 
 
 
 
 
Once in the “User Accounts” dialogue select the option labeled “Turn User Account Control on or off”. 

 
 
 
Finally uncheck the box next to “Use User Account Control (UAC) to help protect your computer” and click “OK”. You may be 
prompted to restart to complete this process. 

 
You are now ready to install Navigator. 
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2.4 Preparing for installation on Windows 7  

 
Step 1. Make sure you are running under a windows user that is a member of the local “administrators” group.  Navigator requires 
administrative access to operate correctly.  
 
Step 2. Selecting the correct network type. The first time your computer is connected to a network, it will ask what type of 
network you are connecting to. For Navigator to have the ability to see and be seen on the network, you need to select the “Work 
network” setting. 
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Step 3. Disable the “sharing wizard”. This can be done by going to control panels and selecting “Folder Options” 

 
 
 
 
Once in the “Folder Options” dialogue select the “View” tab and scroll down to the “Use Sharing Wizard” selection, deselect the 
option, and click apply. 
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Step 4. Disable the User Account Control (UAC). This can be done by going control panels and selecting “User Accounts”. 
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Once in the “User Accounts” dialogue select the option labeled “Change User Account Control settings”. 

 
 
 
Finally slide the slider bar to the bottom setting of “Never notify” and click “OK”. You may be prompted to restart to complete 
this process. 
 

 
  
You are now ready to install Navigator. 
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Chapter 3 – Navigator Installation 

3.1 Navigator installation from the DVD  

Make sure no security dongles are attached to the PC. Insert the Navigator DVD.  
The Navigator disk will automatically launch the install screen. Two buttons are available. 
 

 
 
1. Full Install (Installs Navigator Server, RIP, and Client)   
2. Client Install (Installs the Client only. To be run on networked Windows computers.) 
 
 



  

 

 
Page 16 

 
  

The on-screen prompts will guide you through the entire installation.  

 
 

 

 
 
Unless you have a good reason, the default location is best for the installation.  
 
The system will ask for license codes. Refer to the code sheet that came with your system and enter the codes.  Without 
the proper codes the system will not operate. 

 

 

 

3.2 Restart your PC 

After installation restart your computer.  During the start up process you can attach the dongles and the printer USB cable.



 

 
 

Chapter 4 – Getting Started 
 

4.1 Launching the Software 

Verify the installation of your dongle before launching the application. Without the dongle, the License Manager will not 
allow the software to run. The dongle must be properly inserted into an available USB port. 
 
The Installer places Shortcuts for the Server and the Client on your desktop.  The system is launched by starting the 
Navigator Server.  If you wish you could make a copy of the desktop shortcut and put it into the startup items folder so it 
will be automatically launched whenever the computer is turned on.  The Client may optionally be launched from this 
computer, or on any Macintosh or Windows computer on the network.  Installers for the clients are on the disk. 
 
 
Note: If your system has a Firewall installed you will see a number of alerts the first time the Navigator system starts. 
Programs that may ask for authorization include NAVIGATOR SERVER, SOAR, JAVACORESOAR, PDFSERVER.EXE, 
and others. For each component, permit the software to run, and check the box to make this permission permanent. Once 
each component has been authorized it will not need further permissions.  
 

4.2 RIP Configuration 

Navigator is a Harlequin RIP component to the Navigator system. In normal operation the user will not need to interact 
with it.  If there are problems at the printer (paper jams, running out of ink, etcetera) the “disable output” check box will 
automatically engage, stopping the RIP from sending jobs to a printer that needs user intervention.  Once the problem is 
cleared up the user may uncheck that box here and jobs will continue to print.  However, this function may also be 
engaged in the client and the user need not ever engage with the RIP directly.  The Output Controller should be set to 
Delete Always and uncheck Disable Output, as shown below. 
 

Output Controller Configuration 

 
 

Configure Page Setups from within the RIP menu by selecting Navigator, Page Setup Manager.  Do not delete the 
default page setup.  Once this initial configuration is completed, users will be able to select these Page Setups from 
within the Client application at any Mac or PC on which it is installed.  See the Navigator User Guide for more information 
on RIP configuration.   The Navigator installer creates all the Page Setups that a normal user will require. 
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4.3 RIP Page Setups 

The RIP stores configurations using a system of Page Setups.   Knowledge of Page Setups is largely unnecessary in 
Navigator unless you are an advanced user and wish to make customizations.  If this is the case, see the RIPs user manual on 
the installation DVD.  For most users, the automatically created setups will provide all the control needed.   
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Chapter 5 – Server Configuration 
 

5.1 Introduction 

After launching the Navigator Server application, the Server Dialog appears on the Server PC: 
 

Navigator Server Dialog 

 

 
This window displays information about the Server including its serial number, name and other variables. You may display 
or hide the Tool Bar and Status bar through the View Menu. To exit the Server, use the File > Exit menu selection or the 
Exit button at the top right corner of the window. 
 
A special user account called Administrator has full rights to configure the Server. Upon installation, the Administrator 
password is blank. The only active menu item is Server Setup > Administrator Login. Choose this option, and click 
OK, leaving the password field blank. You now have access to the full range of Server features. We recommend setting a 
password for the Administrator user during initial set-up. Go to Server Setup > Users dialog (see section 5.2 below) to 
set the password. Any further changes to the configuration will require logging in as Administrator and entering the 
correct password.  
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The Server may be configured when it is installed and when changes to the system are required. The most common change 
after installation is the addition of new Users.  
 
Configuration options are: 
 

 Add, delete, or change Users 

 Upgrade product 

 Manage Actions (processes managed by the Server) 

 Set locations on the system for storing workflows and jobs 

 Set Server Name (for cases where there are more than one Server) 

 Set custom field names (for organizing and sorting jobs) 
 
Access these options via the Server Setup menu item, as discussed in detail in the following sections. 
 

5.2 User Management 

All system users must register with the Server. Depending on the options purchased, the system limits the number of 
Users who can simultaneously connect. However there is no limit to the number of users who can be defined at the Server. 
For example, you might have a 5-User system, but 12 employees who work different shifts. You can define 12 different 
Users at the Server, and any 5 of them can be connected at one time. If you wish to upgrade your system to support more 
simultaneous Users, this can be done via a password through the Upgrade Product dialog. 
 
To manage Users select the Server Setup > Users menu item. 
 
To create a new User 
Click Add, and enter the User name and Password as shown in the next figure labeled Create a User on page 16. 

 
Note that a password is not strictly necessary. If this field is left blank, this User may connect to the system without a 
password. Specify the User type by clicking one of the Radio Buttons. Choose Administrator or Standard User, or by 
clicking on the permissions button, create a Special User. The Permissions available are shown in the figure labeled User 
Permissions on page 16.  
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Create a User 

 

 
 
 

User Permissions 
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Depending on the type of User created, certain restrictions will apply. For instance, Administrators have all Permissions 
allowed while Standard Users can only Delete or Release jobs. Special Users are created if you select any other 
combination of Permissions. After establishing Permissions, click OK until the system returns to the User dialog shown 
earlier. Confirm the new User(s) is/are shown correctly.  
 
To Delete A User 
Access the Users dialog (Server Setup > Users menu), highlight the User to delete, and click Delete. 
 
To Modify a User Account 
Access the Users dialog (Server Setup > Users menu), highlight the User to change, and click Modify. Make the 
changes as outlined above for a New User. 
 
When all changes or additions are complete, click Done to close the Users dialog. 
 

5.3 Upgrade Product 

Navigator uses a security system based on the combination of a dongle and a series of codes to enable or add specific 
functions. In addition it can run for up to 90 days in Trial Mode. If your system is in Trial Mode, all connected Clients will 
display the mode, and number of days left, at the top of the Client window. 
 
To convert a Trial Mode system to a full system it will be necessary to obtain codes and a dongle, from your supplier. 
Connect any new dongle and add codes by navigating to the menu item (Server Setup > Upgrade Features). The 
following dialog appears: 
 

Entering Upgrade Codes 
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The upper portion of the window displays the dongle Serial Number; the maximum number of simultaneous Client 
connections; whether or not this system is a Trial (Demo system with an associated expiration date); the maximum 
number of RIPs that can be managed; the soft proof Viewer version, and the Product Version number. 
In the lower center of the screen is a list of Actions that are available in the software. To the right of each Action is the 
word “Yes” if the Action is currently active or “No” if it is not. To enable currently disabled Actions, add a new RIP or 
Client connections, or change your PGB Viewer type, you must first obtain the appropriate code from your supplier.  
 
To install the upgrade, enter the code into the boxes at the base of the dialog and click OK. Upon verification by the 
system the option will be added or changed. 
 
Note: You will also need an upgrade code if you have upgraded from one product Version to another. For example 
upgrading from Version 1.x to Version 2.x will require a Version Upgrade code. If your system requires a Version 
Upgrade, the following dialog will appear after launching the Server application: 
 
 

Version Upgrade 
 

 
 

 

 
Enter the Version Upgrade code and click OK. 
 

5.4 Manage Actions 

“Actions” describe the individual steps or processes Navigator Server uses in the construction of workflows. For example, 
the RIP Action is a basic action that controls the RIP portion of an Navigator system. Other actions are optional, and the 
choices shown in the dialogs will depend on the version of Navigator Server. 
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To configure Actions, select the menu item (Server Setup > Actions). The Actions Manager dialog will appear as 
shown in the figure on page 19. The install creates several actions. You may wish to create more. Only configured Actions 
will be available for Users creating workflows. 
 
 
 
 
 
 

Actions Manager 
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5.4.1 The RIP Action 

From Navigator Server’s Actions Manager click New, select  RIP  from the list of Workflow Agents, and name the Action. 
This is the name that users will see from their Client workstations so choose a name that will be helpful to your users; 
especially if you have more than one RIP. The following figure shows an example of a RIP Action dialog box: 
 

RIP Action Configuration 
 

 
 

Note: If you are connecting a RIP that resides on the same PC as the Server, simply check the RIP is local… check box 
and the configuration will complete automatically. 
 
If you are configuring a RIP Action for a RIP that is not on the same PC as the Navigator server, use the Browse button to 
locate the shared xipgb folder on the RIP.  Navigator Server will attempt to communicate with the RIP immediately.  
 
The timeout value is the length of time the Server will wait for a job to be processed by the RIP before reporting an error.  
If you are processing very large, highly complex jobs, you may find the system reports an error when in fact the job is still 
running correctly. If so, set a larger value than 1200 seconds. (note:  the default is fine for any installation we currently 
know about) Click OK twice to close the Workflow Actions Manager and return to the Server window. 
 
You may repeat this process with as many RIPs as your Server is licensed to support.  Multiple RIP support can take the 
form of several unrelated RIPs driving several unrelated devices or load balancing across RIPs driving similar devices.  
See section 6.4.3 for more information on multi-rip support. 
 
NOTE:  The “Submit PGBs to the RIP’s Output Controller as a group” selection is a compatibility check box for use 
with certain device output plug-ins.  Currently there is no known reason to check this with an M Series Printer. 

5.4.2 The RIP Output Action  

If a RIP Action is configured in the Server (Server Setup > Manage Workflow Actions), both RIP Action and RIP Output 
Action will be enabled. The RIP Output Action will be named by appending ‘Output’ to the name of the RIP Action. 
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The purpose of the RIP Output Action is to take input from a RIP Action which is configured to produce output suitable 
for a particular device, and to send that output to the device. So for the workflow configuration in the Client, a RIP 
Output Action must be preceded by a RIP Action which is associated with a Page Setup for an output device. 

5.4.3 Ink Remapping Action  

Adjusting Spot Colors is done with the ink remapping action.  If you need to add one to your Navigator system, name it 
something like “spot color adjustment” and configure it with “Simple” mode as shown in the picture below.  Advanced 
mode is appropriate for printing separations.  Simple mode is appropriate for printing composite color work such as is 
normally printed on an M Series Printer. 

 

 
  
 
 

5.5 Set System Paths 

The Server Administrator can configure the RIP Manager Server, controlling the storage location of Workflows, Job Files, 
and Archives. By default, these are sub-folders in a folder named “Navigator,” located on the “C” drive of the Server PC. 
However, the Administrator may change this to any accessible location. For better performance, we recommends the Jobs 
and Workflows folders remain in the default location. The Archive folder may be placed on a remote or removable drive.  
 
The system databases are archived by default into a folder named “Archived DBs” within the folder containing the Server. 
These archives are written every 24 hours, and are intended for manual recovery in the case of loss of the Server PC’s hard 
drive, so you may wish to set their location to a remote networked drive. If so, please ensure that the drive can be written 
with a sufficiently high transfer rate. 
 
Note: When a User creates a Workflow, the system creates a Hot Folder with the Workflow Name inside the System’s 
Jobs folder. Make sure that there is sufficient space in the designated location to store all the jobs expected to reside on the 
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system at one time. Keeping several days’ or weeks’ worth of jobs on the system is possible only if sufficient drive space 
exists. 
 
To set System Paths, select the menu items Server Setup > Set Base Workflow Path, Set Base Jobs Path, Set Base 
Archive Path or Set Base Database Archive Path. In either case, the entry box below will appear. Enter the 
required path to the location you wish to use, and click OK. 
 

Set System Paths 
 

 
 

 

 
Click OK to save the settings and close the Path Configuration windows. If you have changed the Workflow or Jobs 
database locations, the Server will now shut down; restart it to make these changes effective. 
 

5.6 Server Settings 

To change the network name of a Server (i.e. the name that Client sees), select the menu item Server Setup > Server 
Settings.  This is normally only necessary if you have two Navigator Servers running on the same network. 
 
The system protects itself by halting job processing if the free disk space falls below a threshold level. By default this is 5 
gigabytes.  For troubleshooting purposes, you may need to change this.  In normal operation the default value is correct. 
 
The client application can set a job to delete “when necessary.”  The “when necessary” threshold is defined in terms of the 
number of jobs in the system and may be modified here. 
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Server Settings 

 

5.7 Custom Field Labels  

Navigator includes a range of features for organizing lists of jobs and related information for users. Some of the most 
powerful are the Custom Fields. These are four fields that can contain any information the user wishes. This information is 
then available for display and sorting purposes by each user from within their Clients. 
 
Defined at the Server, Custom Fields can be given appropriate names that apply system-wide. Users can then add 
information to each field on a per-job basis from any Client. 
  
To define Custom Field names, select the menu item Server Setup> Edit Custom Field Labels menu. Enter the 
Names you wish to use in the four boxes, and click OK. Name the fields any way you wish. Keep in mind that when a User 
chooses to display these fields, they will be displayed in order from left to right on the User’s screen, with Field # 1 
appearing first. 
 
In the following example, the System Administrator has chosen to allow display and job sorting on Customer name, Due 
Date, and the name of the prepress operator responsible for the job. 
 

Custom Field Labels 
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5.8 Import Files 

This dialog is reserved for possible future feature additions.  
 

5.9 Creating Profiles.  

This dialog is reserved for possible future feature additions. 
 

5.10 Color and Name Tool  

This dialog is reserved for possible future feature additions.  

5.11 Install Script 

This dialog is for field upgrades and feature requests.  It is not for general use.  



 

 
 

Chapter 6 – Client Installation 
 

6.1 Introduction 

Navigator Client is the software you actually use every day for printing to the M Series Printers. 

6.2 Installing the PC Client 

Begin by inserting the Navigator disk into your PC’s DVD drive. The install window will appear and offer you two 
installation choices:  the full product or the client only.  If you installed the full product this will have installed a client onto 
the server machine as well.  For each computer you wish to print from, install the client. 
 
After installation of the client application on any computer you may need to mount the Jobs and Workflows volumes. 
The Server installer automatically created these volumes and set them up for sharing.  
 
To manually attach the shares from a Windows PC, open any window and type \\<machine name>. After you enter 
any required password, the window will display shares. Right-click on the Jobs volume and choose Map Network 
Drive. Repeat the process for Workflows.  
 

 

 

Manually Attaching Shares 
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6.3 Installing the Mac Client 

The Macintosh Client is located at the root level of the disk.  Insert the disk into a Macintosh and open the disk.  Just copy 
the application to the Applications folder.   
Note: OSX Macs are able to mount folders shared by Windows.  Navigator will automatically mount these as needed. If 
you wish to turn off auto-mounting of shares, do so from the preferences menu in the Client software. 
 
To manually attach the shares from a Macintosh: Through Finder, navigate to the “Go” menu and choose Connect to 
Server. Type smb://<machine name>/Jobs.  Repeat the process for “Workflows.” The following example 
illustrates the dialog box 

Mounting Shares on OSX 
 

 
 

 
 



 

 
 

Chapter 7 – Get started with Navigator client 

7.1 Introduction 

Once the Server has been set up, the Client can handle all operations. This Chapter describes how to use the Client for the 
most common of these operations. It is based on the PC Client, but the Mac version has the same basic appearance and 
features.  
 
This chapter will get you printing right away.  A detailed list of the controls and their functions is available in Chapter 11 –
Client Detail.  
What follows is a typical view of the Client Graphical User Interface (GUI): 
 

Client GUI 

 
 

 
 

 

 
The GUI has a number of regions, noted here starting from the top: 
 

 Menu Bar – Control menus 

 Tool Bar – Displays icons of frequently used controls 

 (Left window panel) Workflow or Workflow Component “picking” area. 

 (Top right window panel) Current Workflow Diagram 

 (Lower right window panel) Job List 
 
Functionality of these areas will vary according to context, but the general layout remains the same. 
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There are several steps to creating and using Workflow setups, which will be reviewed in sequence. Not all users have to 
know all the details of workflow creation. For example, Users can manage workflows created by others without having to 
learn how to create or modify workflows themselves. Also, the Administrator may limit the permission of users to make 
changes. If one or more of the controls discussed in this chapter appear “grayed out,” or not useable in the Client, it may be 
necessary to verify the User permission settings with the Administrator. 

7.2 Logging In 

After launching the Client application, the following window appears.  Log in with either of the two built-in accounts, 
Administrator or User.  No password. 
 
 

Log-In Window 
 

 

 
 

7.2.1 Locate the Server 

The Client will search the Network for Navigator servers, displaying all that it finds in the Server list box. If you cannot see 
your server, verify that it is running before clicking the Find Servers button. The system will also accept entry of the 
specific Server name or the IP Address of the Server platform using the Add Server dialog. 

7.2.2 User Name 

Enter your User Name and password, if any. User names and passwords are case sensitive. The computer will remember 
your password after activating the Remember Password box. Similarly, the Client will automatically log in to the server 
during the next launch after activating the Automatic Log In box. Note: Activating either of these check boxes will 
allow others with access to your computer to use the Client without supplying a username or password. 
 
Click OK and the Client will attempt to Log In to the Server.  

7.3 Creating Workflows 

During the first login, if there are no jobs or Workflows in the System, an empty dialog will appear. The first necessary 
step is the creation of a workflow by going to the Workflows > New Workflow menu selection. The view will change 
to the Workflow Edit view, and the New Workflow dialog appears.  

(You can also change to the Workflow Edit view at any time by using the icon in the Tool Bar). 
 
Enter a Workflow name in the New Workflow Name dialog and click OK. In this example, the first workflow name is 
“Envelopes - Landscape”. 
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New Workflow: Envelopes - Landscape 
  

 

 
 

 

 
In the Workflow panel on the left side of the GUI are tabbed areas displaying all the Workflow Actions previously created 
at the Server.  A new Workflow starts with just an input Hot Folder in the Workflow Diagram area. Select the RIP tab and 
use the mouse to click and drag the RIP Action icon onto the Workflow Diagram. Release the mouse button and the 
system will add the RIP Action icon to the Workflow Diagram. Next, select the Output tab and drag the RIP Output icon 
onto the Workflow Diagram. These will combine into the basic Workflow shown above.   

 

7.3.1 General Workflow Configuration 

Each workflow is configurable through the tabbed menus in the lower portion of the GUI. Under the General tab are the 
following controls: 
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Workflow Name - changes the name of the selected workflow. 
Priority - applied to jobs processed through this Workflow. If there are other Workflows competing for the same 
resource, as is usually the case, then Normal priority jobs are processed in the order in which they arrive. High priority 
jobs are processed ahead of any Normal priority jobs and Low priority jobs are only processed when there are no other 
jobs waiting on the System. 
Get Ahead - controls how many jobs the system will schedule at one time for a processing Action. The default value is 5 
jobs. This should be changed when load balancing multiple RIPs, but not otherwise. 
Send To Workflow - allows completed jobs to be sent to another workflow. This is a common way of linking 
workflows.  Note that Send To Workflow sends the original job file. 
Archive - places jobs in the Archive folder when deleted from the Workflow. 
Delete - instructs the system when to delete jobs. Selecting When Necessary instructs the system to delete the oldest 
jobs in the system when it reaches a default limit of jobs.  Set this job deletion threshold in “Server Settings”. 
 
Accept the default settings in the General tab for the moment, and select the Hot Folder tab by clicking on the tab itself 
or by clicking on the Hot Folder Icon in the Workflow Diagram. 
 

Hot Folder Configuration 
 

 
 

7.3.2 Hot Folder Configuration 

The following controls are available for configuration of Hot Folders: 
 
Input Folder - This selection is preset to the default job location defined in the Server setup. To change the Hot Folder 
location, use the Browse button.  Remember that you are browsing from the location where the Server is installed, not 
your own workstation.  
Use Color and Name Recognition – (This is a tool for support of output devices other than the M Series Printer and 
isn’t currently applicable to that device.) This tool groups multiple TIFF files together as one job. Use with an appropriate 
configuration file from the Server’s Color and Name Tool.   
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Process Files using Script – processes input files with a script.  This is for field customizations and not used without the 
support department.  Contact your dealer for more information. 
Job Name - Several controls allow you to define how the system will name jobs during processing. 
 

The System Job Name (the name displayed in the Navigator Client) may contain up to three parts. Each part is 
set by the three columns of radio-buttons. To construct the Job Name, click on one button from each column. 
The functions of the buttons are: 
 Job Title –Original document name extracted from the postscript or PDF. 
 File Name – name of the file that contains the job 

Date and Time – current date and time when the job was accepted into the system 
Job Number –sequential job number 
Edit Box – any arbitrary text 
None – no entry for this part of the name. 

 
 
Hold After – Activating this check box causes all jobs to enter a hold state after processing. The jobs are then manually 
released or sent to another workflow. Note that selecting this option causes a red circle to appear on the Workflow 
diagram to indicate the Hold function is active.  
 
Next, configure the RIP Action. Go to the RIP Action by clicking on the tab or on the RIP Action icon in the Workflow 
Diagram. 
 

RIP Action Configuration 
 

 
  
 

7.3.3 Configuring the RIP Action 

There are several controls in the RIP Action configuration dialog: 
 
Paper Profile – Choose an appropriate color profile for your paper.  There are several supplied profiles which cover a 
range of paper types. If you cannot decide from the list, consult the document “Navigator paper profile cross 
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reference.pdf”.  If you wish to get a custom profile created, contact your dealer.  If you understand color profiling and 
wish to provide your own, you can consult the “ColorPro” document for information on how to install custom ICC profiles 
into the system. 
Print 100% Black with only Black ink – To get the darkest black,  Navigator can make a black with color inks 
underneath it.  Fine lines will not be as crisp when you do this. For reasons of either crispness of edges or economy, you 
can check this box to get a black made only with black ink.  
Pause After – Causes all jobs to enter a Held state after RIPing, but before output. The jobs are then released manually.  
You can preview ripped data prior to output when you check this box. 
Mirrorprint – reverses output.  Useful for transfer applications.  
Font Emulation:  The RIP can create missing fonts from the low resolution preview data in a job.  If your customer fails 
to embed fonts in a PDF file, the RIP can compensate if you check this box.  Without checking this box you might see font 
substitution for Courier when fonts are missing. 
Scaling – scales via percentage numbers.  This can be square (if the numbers are equal) or it can be anamorphic (if the 
numbers are not equal). 
Rotate – there are 4 choices and they are expressed in degrees.  Zero degrees is unrotated.  90 degrees and 270 degrees 
are both 90 degree rotations, in opposite directions.  180 rotates a job so it is upside down.   
Mirrorprint – reverses output.  Useful for transfer applications.  
Configuration and “refresh configs” – A Harlequin RIP uses a framework known as a “Page Setup” to store RIP 
configuration data.  If you are familiar with Harlequin RIP operation and wish to create some more, you may certainly do 
so.  After the installation of Navigator, there is just one configuration, M Series Printer.  This is all that is necessary. 
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7.3.4 Configuring the Output Action 

 
 

Output Action Configuration 
 

 
 

 
 

Reverse Output Order – causes the last page to output first, and the first last.  This is useful for ordering a multiple 
page document properly.  
Copy Count – Enter any number here to change the number of copies printed.  This feature is also found in each job’s 
contextual menu (right-click on the job). 
Pages – All or From X to X.  This allows control over which pages you print in a multiple page job. 
Print Quality – The printer is capable of two quality modes; Best, which outputs at 6 inches per second and at a 
resolution of 1600x1600; and Fast, which outputs at 12 inches per second and a resolution of 1600x800.   
Print Offset – Use this to move the image around on the paper until it lands in the correct place.  This should only be 
used if necessary.  Try printing some jobs before you change this.  If jobs are shifted on your printer, adjust it here. 
Collect Pages before printing – Please leave this checked unless instructed to do otherwise by support.  
 

Click the  button to commit the changes.  Your workflow is ready to receive jobs, rip , color manage, and output 
them to the printer.   
  

7.3.5 Submit a job to the client 
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If you have  a PostScript or PDF file of your job the easiest way to submit it to a Workflow is to drag it onto the client 
window. You can either drop the job on one of the workflows on the left side of the screen, or onto the large workflow 
image at the top of the screen. Both have the same effect. The system will place the job in the designated Hot Folder and 
the workflow will process it as if it had arrived in the Hot Folder from elsewhere. 
 
You may also select the menu option “New Job”, navigate to your job, and choose a workflow from the drop down menu. 
 
To test your workflow drag a PDF file onto the workflow diagram, or onto the workflow folder in the left column, or into 
the hotfolder located at C:\Navigator\Workflows\Envelopes – Landscape.   
 
 
 

Chapter 8: Color Adjustments 
 

8.1 Spot Color Adjustments 

 
Spot Color adjustments takes the form of a workflow action. The ink remapping action performs two functions.  For 
separation devices such as film or plate imagesetters, it merges spot color plates together.  For CMYK output devices such 
as an inkjet device it allows changes to the CMYK recipe for a particular spot color. It is this function which we are 
interested in with the M Series inkjet devices.   At the Server, the configuration looks like this: 

 
 
 
The spot color adjustment tool may be dropped into any workflow. The function requires PDF files with identified spot 
colors to operate. 

  
 
 
Below is a workflow with spot color adjustment enabled. 
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If you wish to adjust the colors for each job, put a pause after the spot color adjustment in the workflow editor.  If you only 
wish to adjust colors after having first printed a copy, put no pause.  After outputting one copy, right-click the job and 
choose “spot colors” from the contextual menu. 

 (or click the  button) at the top of the screen) 
 
This will allow you to enter the spot color adjustment dialog box.  
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If the user is comfortable editing the Cyan, Magenta, Yellow, and Black values directly, they may do so here.  Most users  
will prefer some help from the system in getting the right color.   
Click “Swatch Sheet” in order to get that help. 
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The swatch sheet window has controls allowing the user to vary the color from swatch to swatch and print out a letter-
sized sheet or a #10 envelope with a swatch sample resembling the swatch window.   
Choose two colors to change and choose a step amount to control how much the change will be.   
Choose a paper size and click Print Swatch Sheet. 
(Note:  This function requires a workflow called “SwatchPrint” that connects to the M Series Printer and consists of a 
hotfolder, a RIP action, and an output action.   This workflow will have been installed by default but if it has been 
inadvertently deleted, you may simply recreate it) 
 
Your swatch sheet will print. 

   
 
You may fold it, tear it, use it however you like.  Compare it to acceptable printed output, compare it to a printed 
swatchbook, compare it to a t-shirt, or anything at all that you would like to get closer to. 
Click the square you think is closest and it will become the center square.  Then, you can output again and try to get 
closer, or commit the changes and output your job. 
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8.2 Spot Color adjustment databases 

Once you adjust a color, you are free to use it again and again as long as you save it in a database. 
 

 
 
Instead of leaving the color edits to affect “Current Job Only”, choose a database from the drop down menu to save them 
to.  Or click the + sign to the right to create a new database. 
 
 

 
 
Pick a name that will help you to know when to use this database in future. 
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Add notes that help to describe the proper use of the database. 
 
You can then choose this database in a workflow so that it automatically processes incoming  jobs with the color edits in 
that database.  No user intervention required.  You might name a database after a particular customer, or a paper stock. 
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8.3 Global Color Adjustment 

Global color adjustment works on any file format the system accepts.  (e.g. postscript, PDF, EPS, TIFF)  It works on every 
color in a job.  Whether the job contains RGB, CMYK, spot colors, or a combination of all of these, the global color 
adjustment tool will adjust the color of the entire job. 
 
Its function is simple.   
When you wish to use it, right-click a job and choose “edit workflow for this job”. 
On the RIP tab click “color adjustment”
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When you click color adjustment the window pops up 
 

 
 
Simply click to the right or to the left.  
The color wheel is provided as a reference to color relationships.  When you add cyan ink, it has the effect of removing red 
from a job.  When you remove yellow it has the effect of increasing blue.   
 
 
 
The color adjustment below will make the job darker.

 
 
 
This color adjustment will make the job print with more magenta ink (which has the effect of reducing green). 
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This color adjustment will lighten job and also remove magenta.

  
  

Chapter10: Previewing jobs  
 
The Navigator system includes an integrated Viewer to preview jobs after RIPing and before output. This section will 
illustrate the preview of both composite color images intended for proofing and separated, screened images intended for 
final output. 
 

Return to the All Jobs  view. Locate or create a job that has been run and held. Double-click on the job (or click 
on the plus symbol) to expand the job “tree.” Repeat this process on each folder revealed until the whole tree has been 
expanded. If the job was a color job and was allowed to process to the point of a pause after the RIP, it should look similar 
to the job shown below 
  

Expanded Job Tree with Composite PGB 
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Under the folders you will see two files. The original job file with a “.ps” (PostScript) extension and the RIP Page Buffer 
file (PGB). The PGB file is identifiable by its location within the RIP folder because only Page Buffer files can appear here. 
The fact that there is only one PGB file for the job and that it has a multicolored icon as shown above tells us that this is a 
Composite Page Buffer.  

Highlight the PGB file, right-click and select View PGB; or click on the  Preview button; or double-click the 
PGB file. 
 
The Viewer will launch and details of the PGB file appear in the lower right panel labeled, “Info.” (See Appendix A for 
complete details about the Viewer.) Select the Navigator tab to see a thumbnail view of the page. Click on the image and 
the main panel will shift to a 100% scale view of the same area. Zoom in and out by selecting the + and – buttons and 
double-clicking on the image, or by selecting a resolution from the list. Pan the image by holding down the mouse button 
on the image and moving the mouse around. 
 
The Preview will be similar to the example shown below. 
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Preview Image 
 
 

 
 

 
Use the Preview to check the job for proper orientation, fonts, dimensions, etc., before releasing it to the next stage 
(provided the Workflow is set to Hold in the RIP Action Configuration tab). Close the Preview window and return to the 
Job View in the Navigator Client. 
 
This time expand one of the jobs with an orange triangle in the Hi Res Workflow. 
 
Because these are separated Page Buffers, the expanded tree will look like the example below. 
 

Expanded Job Tree with Separated PGBs 
 

 
 

Again highlight one of these PGBs and select the  Preview button. 
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With a file created for final output to an imagesetter or platesetter, the preview image will show the screening used during 
the RIPing process. It is also possible to display individual colors or combinations to review traps, knockouts and 
overprints. 

Preview with Screened Image 
 
 

 
 

 

For more details on the viewer see Appendix A. 
 

10.8 Final Output 

After approving the job based on the preview image, output the separations to the plate or film device by right-clicking the 
job and selecting Release to next step. 

10.9 Deleting & Archiving Jobs 

To delete jobs from the system, highlight them (select a group of jobs together using the mouse and the shift or Ctrl. key 
on the PC, or holding the mouse button and dragging the mouse over the files on the Mac). You can then either right-click 
and choose Delete or use the Jobs menu to access the Delete selection. Also, after highlighting you may delete jobs by 
using the Delete key on the keyboard, or the Delete Jobs button in the client window. 
 
Earlier, we activated the Archive check box in the General tab of the High Res Workflow. Therefore, after deleting jobs 
from this Workflow, the system automatically archived them. To retrieve these jobs, path to the System Archive location 
set during Navigator Server configuration.  Within the Archive folder, Navigator creates dated folders for each month that 
jobs were archived. Within each monthly folder are dated folders for each day. Jobs archived today will be in a folder 
labeled with today’s date. Re-introduce these jobs to Navigator by using the File > New Job menu selection and fetch the 
job from the Archive folder. 
 
Note: The system archives the original files (PostScript, PDF), pre-flighted files and other intermediate steps. The system 
does NOT archive the RIPed page buffer files. 





 

 
 

Chapter 11 – The Navigator Client in Detail 

11.1 Menu Bar Items 

11.1.1 The File Menu 

 
The File menu contains the following items: 
 

New Job 
This selection opens the New Job Window for associating files with a workflow and importing jobs for 
processing. When using this method to submit jobs, choose the job for processing and the workflow that 
will process it. 
 

Login 
This selection allows a user to log into the Server. It is only an option when there is no user already 
logged in to the system.  
 

Logout 
This selection allows a user to log out of the Server. It is only available if a user is logged in. 
 

User Info 
This selection opens a dialogue supplying the following information about the current user: User Name, 
User Rights / Permissions, Name of the Server to which the Client is connected. 
 

Reset Preferences 
This selection resets Client Preferences to factory defaults.  
 

Exit 
Selecting Exit closes the Client. 

 

11.1.2 The Jobs Menu 

 
The Jobs menu contains the following items: 
 
Note: The items listed below are only valid in relation to a Job within the Workflow. They will only become available after 
highlighting (selecting) a job in the Client Job List. 

 
 
Get Info 

This selection opens the Job Information Window.  

 This function is also available by right-clicking on a job and choosing Get Info from the pop-up 

menu, or by clicking the Get Info  button on the Tool Bar. 
The Job Information Window provides an overview of the job. It can be used to change the job name 
reported in Navigator Client and enter data into the Custom Fields. Other information displayed 
includes Job Status, the Workflow name where the job resides and a log of the job’s progress through the 
system. 

 
Flag 
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This marks a job so that it may not be deleted.  In order to delete a flagged job, it must first be “un-
flagged.”  This may be useful for repeat work. 
 
 

Delete 
Selecting Delete after highlighting a job will cause the system to delete the selected file. Use delete to 
remove any job or sub-file within a job.  
 
For example, it is possible to use delete to remove an unwanted PGB (RIPed page or separation) file, or 
an unwanted color at the last minute before sending the job to output. Note: Deleting a sub file will 
remove it from the system entirely. 
 

 Delete will only be available after highlighting an appropriate file in the Job List. 

 This function is also accessible by right-clicking on a job and choosing Delete from the pop-up 
menu or by clicking the Delete Button on the Tool Bar. 

 
Edit Workflow for This Job  

This will put the Navigator Client in Edit Workflow mode for making changes to the workflow of the 
selected job ONLY. (On the Mac client, this reads Edit Workflow) 
 

 This function is also accessible by right-clicking on a job and choosing Edit Workflow for this 
Job from the pop-up menu. 

 
This is a powerful tool that allows changes to the workflow settings only of a specific job. For example, if 
a job errors when sent as a PostScript file, running it through the Stabilizer to create a PDF file may 
allow it to run. Using this option, a user can add a Stabilization Action to the workflow of the selected 
job. By releasing only the file in the “Hot Folder” to the next step, the system will re-process the job, this 
time with a Stabilization Action. Similarly, if a PDF job errors, a user can add a Preflight Action to the 
selected job’s Workflow without having to create an entirely new Workflow to perform the specialized 
Preflight task required.  
 

 
Pause Job 

Choosing this selection will cause the system to pause processing of the selected job.  
 

 This function will only be available if the selected job status is such that a pause is a logical step. For 
instance, Pause Job will not be available if the Job’s Status shows Completed. 
 

 This function is also accessible by right-clicking on a job and choosing Pause Job from the pop-up 
menu. 

Copy  
This menu item will open a list of established Workflows in the system. Choosing one of the Workflows 
listed will cause the system to process a copy of the job using the selected workflow. The original Job 
remains unchanged. 
 

 This function is also accessible by right-clicking on a job and choosing Copy from the pop-up menu 
or by clicking the Copy Button on the Tool Bar. Using the PC client, a user can also drag and drop 
the job while holding down the Control Key. Using a Mac, the same function is available using the 
Option Key. 
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Restart Job  
This menu item will open a list of established Workflows in the system. Choosing one of the Workflows 
listed will cause the selected job to restart from the beginning, using the original input file, through the 
new Workflow selected. 
 

 This function is also accessible by right-clicking on a job and choosing Restart Job from the pop-up 
menu or by clicking the Restart Job Button on the Tool Bar. In addition, simply dragging the job 
onto a new Workflow will have the same effect. 

 
Release to next step 

This selection releases the selected job from a Hold or Pause Status to the next process specified in the 
Job’s Workflow.  
 
 This function is also accessible by right-clicking on a job and choosing Release to next step from the 

pop-up menu or by clicking the Release to next step Button on the Tool Bar. 

 
 

Send selected file to next step 
Releases the selected file from within a job – an individual PS/PDF/PGB (a RIPed page or separation) – 
file to the next process specified in the Job’s Workflow.  
 
For example, if it is necessary to release only one of the pages or separations of a job to the Output 
Action for imaging, it is possible to highlight the desired page or separation and, by choosing Send 
selected file to next step, only release that separation or page for output. 
 

 Send selected file to next step will only be available after highlighting an appropriate file in the 
Job List. 

 This function is also accessible by right-clicking on a job and choosing Send selected file to next 
step from the pop-up menu. 

 
Set Priority 

This menu item will open a list of Job Priority settings (Low, Normal and High). Choosing one of these 
priority settings will change the priority for the selected job.  
 

 This function is also accessible by selecting the job, right-clicking and choosing Select Priority. 
 
Open File 

Choosing this menu item will open the selected file in the proper editing/viewing program. For 
example, after highlighting a PDF file and selecting Open File the PDF file will open in Adobe Acrobat 
for review and editing, provided Acrobat is available on the system. Similarly, The Viewer will launch 
after highlighting a PGB file (a RIPed page or separation) and selecting Open File.  
 

 Open File will only be available after selecting an editable or viewable file type in the Job List 
window. 

 This function is also accessible by right-clicking on a job and choosing Open File from the pop-up 
menu, by clicking the Open File Button on the Tool Bar, or double-clicking on the PGB or PDF 
file. (PDF files will only open if you have Adobe Acrobat or Acrobat Reader installed on the 
system.)  

 
See Appendix A for a description of the Viewer and Viewer functionality. 
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The following two items are for configuration preferences and are not job related. They are available at all times. 

 
Column Headings 

This selection opens a dialogue allowing the user to turn on and off the column headings that display job 
information in the Job List Window Panel. 
 
 

Viewer Properties 
This menu selection opens a window allowing the user to adjust Viewer settings such as disk usage, 
memory allocation and initial down-sample sizes. See Appendix A, Section A.2 for details. 
 
 
 

11.1.3 The Workflows Menu 

 
New Workflow 

This menu selection begins the process of creating a new workflow. 
 

Cancel Any Changes 
Cancels all changes made in creating or editing Workflows during the current editing session. This 
option will be grayed out (unavailable) if the user is not in Workflow Edit Mode. 
 
Note: If you leave the Workflow Editing mode by changing to a Job View mode, all changes made 
during Workflow Editing are automatically saved and applied to all future jobs. 

 
Copy Workflow 

This selection opens a sub menu listing all of the Established Workflows in the the system. Choosing one 
of the listed Workflows will copy its parameters to a new Workflow. The user must provide a new name 
for the copied Workflow. After copying and naming a Workflow it will immediately be available for 
editing. This function is also accessible by right-clicking on a workflow icon in the Left Window Pane 
(Workflow list) and selecting Copy Workflow (Control-click on a Macintosh). 

 
Edit Workflow 

This selection opens a sub-menu listing all of the Established Workflows in the the system. Choosing one 
of the listed Workflows will allow editing of the parameters for that workflow. The system will save 
changes when exiting Workflow Edit mode using the “Edit workflow Icon” in the Tool Bar or by 
changing from the Workflow Edit mode to a Job View mode. This function is also accessible by right-
clicking on a workflow, and selecting Edit Workflow (Control-click on a Macintosh), or double-
clicking on the Workflow name. 
 

11.1.4 The Help Menu 

 
About  

Selecting this displays the release version and Copyright information for the Navigator Client. 
 
 

11.2 Tool Bar Items 



 

 

 
Page 57 

 
  

The tool bar uses graphic buttons to represent the most commonly used Navigator Client functions. From left to right, the 
three sections are; Job View, Workflow Edit, and Job Management. 
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11.2.1 Job View Section 

 
The View All Jobs Button: 

 

   
 
Clicking this button will place the Client in Job View Mode. The left panel of the Client window will 
display icons for each of the established Workflows. The right panel of the Client window will display a 
list of all jobs in the system. 

 
The View Held Jobs Button: 

 

 
 
Clicking this button will place the Client in Job View Mode, but will only show those jobs that are on 
hold. The left panel of the Client window will display icons for each of the established Workflows. The 
right panel of the Client window will display a list of all held jobs in the system. 
 

The View Completed Jobs Button: 
 

 
 
Clicking this button will place the Client in Job View Mode, but will only show completed jobs. The left 
panel of the Client window will display icons for each of the established Workflows. The right panel of 
the Client window will display a list of all completed jobs in the system. 
 

11.2.2 Workflow Edit Section 

 
The Edit Workflow Button: 

 

 
 
Clicking this button will put the Client into Edit Workflow mode. (Or, if you are already in Edit 
Workflow mode it will return you to Jobs View mode.) The currently selected or last selected 
Workflow will be the one the system opens for editing. This function is also accessible by right-clicking 
on a workflow, and selecting Edit Workflow (Control-click on a Macintosh). 
 
The left window panel in client will display a list of Available Workflow Components called Actions. 
The upper right window panel will display a graphical representation of the selected Workflow 
configuration. The lower right window will display the configuration tabs for the selected workflow. 
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11.2.3 Job Management Section 

 
Release to Next Step Button 

 

 
 

Releases the selected job from a hold applied in the Workflow Configuration (or a manual Pause) to the 
next process specified in that Workflow. This selection will be gray and inaccessible without first 
highlighting a job in the Job View Window. 
 
This function is also accessible by right-clicking on a job and choosing Release to next step from the 
pop-up menu or by selecting Release to next step from the Jobs Menu (Control-click on a 
Macintosh). 

 
Delete Button 

 

 
 

This function deletes the selected file. Delete can remove any job or sub-file within a job.  
For example, it is possible to use delete to remove an unwanted PGB (RIPed page or separation) files, or 
an unwanted color, before sending the job to output. Caution; deleting a sub file will remove it entirely 
from the system  
 

 Delete will only be available after highlighting an appropriate file in the Job List. 
This function is also accessible by right-clicking on a job and choosing Delete from the pop-up menu or 
by selecting Delete from the Jobs Menu, or by using the Delete key on the keyboard . 

 
Restart Job Button 

 

 
 

Clicking this Button will open a list of established Workflows in the system. Choosing one of the 
Workflows listed will cause the selected job to restart from the beginning using the chosen Workflow. 
 
This function is also accessible by right-clicking on a job and choosing Restart Job from the pop-up 
menu or by selecting Restart Job from the Jobs Menu (Control-click on a Macintosh). In addition, 
dragging the job onto the new Workflow has the same effect. 

   Copy Job Button 

 

 
 

Clicking this Button will open a list of established Workflows in the system. Choosing one of the 
Workflows listed will cause the system to process a copy of the selected job by the Workflow chosen 
without affecting the original job. 
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This function is also accessible by right-clicking on a job and choosing Copy Job from the pop-up menu 
or by selecting Copy Job from the Jobs Menu (Control-click on a Macintosh). In addition, dragging the 
job with the Control key (PC) or Option Key (Mac) has the same effect. 
 

Get Information Button 
 

 
 
Clicking this button opens the Job Information Window.  
 
This function is also accessible by right-clicking on a job and choosing Get Info from the pop-up menu 
(Control-click on a Macintosh). 
 
The Job Information Window provides an overview of the job. It can be used to change the job name 
reported in Navigator Client and enter data into the Custom Fields (see Section 3.7 of the Navigator 
Server User Guide). Other information displayed includes Job Status, the Workflow name where the job 
resides and a log of the job’s progress through the system. 

 
 
Open File Button 

 

 
 

Choosing this menu item will open the selected file in the proper editing/viewing program. For 
example, after highlighting a PDF file and selecting Open File, the PDF file will open in Adobe Acrobat 
for review and editing, provided Acrobat is available on the system. Similarly, The Viewer will launch 
after highlighting a PGB file (a RIPed page or separation) and selecting Open File.  
  

 Open File will only be available after selecting an editable or viewable file type in the Job List 
window. 

 This function is also accessible by right-clicking on a job and choosing Open File from the pop-up 
menu, by clicking the Open File Button on the Tool Bar, or double-clicking on the PGB or PDF 
file. (PDF files will only open if you have Adobe Acrobat or Acrobat Reader installed on the 
system.)  

 
See Appendix A for a description of the Viewer and Viewer functionality. 

 
 
Toolbox button 

 

 
Choosing this menu item will open a browser window and connect to the HTML server in the printer 
allowing the user to control maintenance and feedback functions. 
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11.3 Post-Processing Bar 

 

 
 

The Post-Processing Bar is an informational icon. It illustrates any actions that will be taken after the 
selected Workflow has completed processing of a submitted file. The Post-Processing Bar displays three 
post-processing functions. 
 
If the icon in the Bar appears in color, that function has been activated for the current Workflow. If it is 
gray, the corresponding function is not active. Each Post-Processing function is available in a sub-section 
of the “General” Workflow Configuration Tab, discussed later in this Chapter. 

 
Delete  

 
 

Delete instructs the system when to delete jobs. Selecting When Necessary instructs the system to delete 
the oldest jobs in the system when it reaches a default limit of 250 jobs. 

 
Archive 

 

 
 

Archive tells the system to Archive completed files. Archiving will take place when the files are 
scheduled for deletion from the system. 

 
Send to Another Workflow 

 

 
 

This icon indicates that completed files will move on to another established Workflow for further 
processing. 
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11.4 The Job List Panel 

The Job List Panel will take up the entire right side of the Client window or the lower right side of the Client, depending 
on the Mode the Client is in. When viewing All Jobs, All Held Jobs or All Completed Jobs, the Job List Panel will take up 
the entire right side of the Window. 
 

Job List Panel 
 
 

 
 

 
Four main functions are possible from within the Job View Window; searching for jobs, reviewing and sorting Job 
information, opening editable or viewable files and controlling Job files. 
 
The Job View Window appears in columns and rows. The columns provide different information about each job. Columns 
are configurable and adjustable for size. Each row in the Job View Window will contain information about a specific job or 
items contained within the Job, if the Job Information has been expanded. 
 

11.5 Items in the Job View Window 

 

Column Headings 
 

 
 

 

Job Information Rows 
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Expansion Buttons 
 

 
 

 
Found at the far left of the Job information row, these buttons are used to expand (+) or contract (-) the 
information for the selected job. 
 

 
Job Status Icons 

 

   Green indicates the Job is Scheduled, Idle or Running.  

  Yellow indicates that the Job is Paused or on hold.  

  Red indicates that the job caused an error.  

  Blue indicates that the job is complete. This icon will appear as a blue circle on the Mac Client. 
 

If the Job View has been set to show the expanded view, the Job Status icons on the PC will point 
downward as illustrated under Expanded Job View below. 

 

 
Location Icons 
 

Location icons indicate the location of files used by - or generated during - the processing of a job. Each 
location is specified by a location icon followed by the name of the Action completed to create the file 
found in that location.  

Location Icons 
 

 
 

The expanded Location Tree shown above illustrates the various steps and files produced in a workflow 
that includes the Stabilizer, Preflight, PDF Checker and RIP Actions.  



 

 

 
Page 64 
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11.6 File Type Icons 

 
File Type icons appear in a number of different styles and colors. Rather than display them all, four representative 

types are shown below: 

 
PostScript File Icon 

 Identifies the file as PostScript 
 
PDF file Icon 

Identifies the file as PDF 
 
Preflight Report Icon 

Identifies the file as a Preflight Report File. The system generates Preflight reports in PDF, 
viewable in any PDF viewing or editing software. 
 
RIPed CMYK Separation Icon 

 Identifies a RIPed CMYK or Gray separation The color of this icon will change depending on the 
separation color. 
 
RIPed Pantone Color Separation Icon 

 Specifies a RIPed Pantone Spot Color separation  
 
RIPed Composite Page Buffer 

 Specifies a RIPed composite page buffer, usually for a proofing device 
 
Unspecified Color RIPed Separation Icon 

 Specifies a RIPed separation of unknown color, usually a Black or Spot separation that has not been 
properly identified to the system. 

 

11.7 Expanded Job View 

Below is an example of an expanded job view displaying various job elements with Job View icons. 
 

Expanded Job Tree 
 

 
 

11.8 Column Heading Functions 

The Job View window contains a number of headings. There are standard heading fields that are not changeable and 
heading fields that are configurable to suit the information needs of a company’s internal procedures.  
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Standard Headings/Columns 
Standard Column Headings can be turned on and off using the Jobs/Column Headings menu but they 
cannot be altered. The one exception is the Job Name heading which is always on. See Chapter 3 for 
more information about turning on and off display of Job View Columns 
 
Job Name 
Displays the Job Name as specified in the Workflow Configuration “Hot Folder” tab or as set in the Jobs 
Information window (see above and Chapter 3 for more information.)  

 
Job Number 
Displays the Job Number. This is a continuously incremented number applied sequentially to jobs as they 
arrive in the Navigator Server system. 
 
Status 
This column displays processing status of the job. It will show if the job is held, processing (RIPing, 
Stabilizing, etc.), paused, post-processing, or completed. 
 
Workflow 
Displays the Workflow the Job is currently assigned to / processed by. 
 
Priority 
Displays the priority setting for the job. Job priorities can be set to Low, Medium, and High. They can 
be set for individual jobs or for all jobs coming into the system from a particular workflow. Priority will 
directly affect the order in which Navigator Server processes jobs. See Section 8.3.1 for more 
information about setting job priority. 
 
Status Message 
This column displays messages that may clarify the Job’s status, such as error messages sent by the RIP. 

 
Configurable Headings 
There are four configurable headings. The view of these headings can be switched on and off in the same 
manner as the standard column headings. The naming of these fields is performed in the Navigator 
Server.  

 
Adjusting Column/Heading Size 
The size of each column is adjustable by clicking and holding the mouse on the left division or gutter 
between the columns. (An example using the Job Name Column appears by the arrow below.) While 
holding the mouse button down, drag the column gutter left to decrease the size of the column view and 
right to increase it. 
 

Column Adjustment 
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It is possible to make a column disappear by dragging the gutter too far to the left. If this occurs, go to 
the Jobs/Column Headings menu and switch off the column that has disappeared. Switch it back on and 
the column will return. 

 
Sorting On Job Heading 
Clinking on a column heading will sort jobs according to the information in that column. A small arrow 
will appear in the column heading to indicate if the sort is in ascending or descending order. Clicking on 
the column heading again will change the sort order to the opposite of its previous setting. 
 

11.9 Controlling Jobs in the Job View Window 

Workflow functions for each Job are controllable from within the Job View window. Clicking the mouse while 
on a job or a sub-file of the job will highlight the Job or sub-file, and right-clicking on the job or a sub-file of the 
job will open the Job Functions Menu (Control-click on the Mac). 
 

Job Controls 
 

 
 

 
The functions of this pull-down menu are the same as the corresponding functions in the Jobs Menu found in the 
menu bar. See the explanation of Jobs Menu functions earlier in this chapter for a description of each menu 
selection. 
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11.10 Display Windows in Workflow Edit Mode 

Any time a user creates or edits a workflow, the Client reverts to workflow edit mode. The Client window changes to 
show RIP Actions, PDF Actions and Output Actions to the left, the selected Workflow Diagram on the top right and the 
Workflow Edit Tabs on the bottom right.  
 

Workflow Edit Mode 
 

 
 

The Workflow Edit Tabs appearing will depend on which components were selected for a particular Workflow. As a 
system grows, users can add new Actions and these will have their own Tabs. To select a tabbed dialog, simply click on the 
named tab.  
 

11.10.1 Workflow Edit Tabs 

11.10.2 General 

The General Tab contains the following Workflow configuration settings: 
 
Workflow Name 
Use this selection to enter or change the selected workflow name. 
 
Priority 
Three selections are available which will determine processing priority: Low, Normal and High. 
 
Get Ahead 

This number represents the number of jobs the system will “pre-schedule” for processing. If, for 
instance, there are 10 new jobs in a workflow and the Get Ahead is set for 5, the system will schedule 
five of the jobs for processing. The remainder of the new jobs will be in “idle” mode. As each job finishes 
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processing, the system will add the next new job, keeping the total of scheduled jobs at 5 or less, until all 
jobs complete.  
 
To optimize the workflow, change the Get Ahead entry to the desired number. 
 
Get Ahead is also available when more than one RIP action is set in the same workflow. By using 
multiple RIP Actions (attached to different RIPs) it is possible to “load balance” the RIPs. Setting a Get 
Ahead value will make sure that one of the RIPs will never be sent more jobs than the other RIP in 
excess of the established Get Ahead number.  
 
That is, with a Get Ahead of 5, the system will pre-schedule five jobs for both RIPs. If one RIP is 
significantly faster, it is possible for jobs to remain scheduled for the slower RIP after the faster one 
finishes. In this case, a lower number (zero) is more conducive to equal distribution of jobs between two 
RIPs of different speeds. 

 
When Job Completes Section 

This special section tells Navigator Server what to do with job files after all processing in the selected 
Workflow is complete. There are three choices as described below:  

 
Send to Workflow 

This is a very powerful tool for setting up complex workflows. By choosing to send a job to another 
Workflow after completion in the specified Workflow, the system can perform multiple tasks on the 
same job without user intervention.  
 
For instance, it is possible to link a workflow set up for proofing to a workflow set up to drive an 
imagesetter. In this way jobs can be proofed and then imaged without having to reprint the job or 
manually restart the job. 

 
Archive 

Enabling this option will tell the system to Archive completed files. The system will store the original file 
in the Archive folder specified in the Navigator Server. Archiving will take place according to the 
deletion settings in the Navigator Server. Turning on Archive when “Send to workflow” is selected will 
have no effect. 

 
Delete 

After checking this selection, the system will delete files either immediately upon completion or as 
necessary after reaching a limit of jobs. This limit is editable in the “Server Settings” dialog box in 
Navigator Server.   

11.10.3 HotFolder 

The Hot Folder tab contains the following options: 
 
Input Folder 

This field specifies the folder a workflow watches to bring jobs into the system. Navigator Server 
establishes a default folder for each workflow a user creates. In most cases this default folder will be 
sufficient and no additional configuration is necessary. With the PC Client, the default folder is 
changeable using the Browse button.  
 
The Restore Defaults button resets the Input Folder to its default setting. 
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Hold After 
Checking this box will cause the system to immediately place newly arriving jobs using this workflow on 
hold. 
 
Once held, users can make changes to the Job’s Custom Information Fields, or restart jobs in a different 
workflow. 

 
Sample Job Name 

This field shows an example of the how job names will appear in the Navigator Server system with the 
words “My Sample Job” representing the incoming job name. As you add or remove options to the job 
naming template this example field will reflect the changes. 

 
Job Name Prefix, Body and Suffix 

The three settings, Prefix, Body and Suffix will add information to the displayed job name in the Client. 
Any mixture of the available settings is acceptable, including a custom prefix and custom suffix field. 
Prefix and suffix settings can also be disabled. However, there must always be a setting for body. 

 

 
 

Appendix A – The Viewer 
 
Note: RIP Manager offers two choices for the Viewer; the standard Viewer and Viewer Pro. The additional features in the 
Pro Viewer are discussed at the end of this Appendix in section A.4 

A.1 Key Features 

 Multiple scale factors – can zoom in and out. 

 Intelligent ordering of files into jobs, pages and separations. 

 Can rotate, mirror and negate the view 

 Can view Traps and Rulers 

 Accurate color mixing and display 

 

PageBuffer Files  
This appendix makes reference to PageBuffer files and it is helpful to understand what these files are and where they reside. 
Harlequin RIPs generate PageBuffer files to store RIPed (bitmap) data. The RIP accesses these files when viewing or 
outputting jobs. Each page or flat to be output is held in one PageBuffer file, so the system stores multiple-page jobs in 
multiple PageBuffers. Some PageBuffer files (usually lower resolution proofing output) contain all the colors in a page or 
flat while others, (usually high resolution screened output) contain only a single color.  

A.2 Configuring the Viewer 

The Configuration Settings enable you to modify settings that are applicable to the whole of the Viewer. The settings apply 
only to the RIP Manager client at which they are made. They will not affect other copies of the Viewer on other 
computers.  
 
To modify the Viewer Configuration Settings: 
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Select Viewer Properties from the Jobs menu in the RIP Manager Client. The window shown below will appear. 

 Viewer Configuration Settings 
 

  
 

Work Space Path sets the location of all temporary files created during processing. 

Allocate to sets how much disk space the Viewer may use. This value should be at least 1000 Mb for small files 
but will need to be 10000 or more for larger files. 

Down-sample controls the Viewer’s down sampling. (Down sampling is the process of reducing the resolution 
of an image by calculating average pixel values for an array of input pixels which are used to create a smaller 
number of output pixels. The options are: 

o Down-sample all factors on view - This option will process all the possible scale factors from 100% 
to the factor that best fits in screen when selecting the view button. 

o To best fit in roam window - This option instructs the system to down-sample by the factor required 
to fit the image into the roam window. 

o Screen resolution and below - Only the closest factor to the screen resolution and those below it 
will be down-sampled. Recommended for best performance. 

Default View sets the default mode for the initial view of the page. Best Fit produces a full-screen view while 
Actual Size shows only a small piece of the full size job. 

Units of Measurement allows the user to set default units for measurements made using the viewer.  

.  
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A.3 Using the Viewer 

Interface Components 
 

 
 
 

 

The Roam Window 
The Roam Window is the area in which the system will display image data.  
 
The Navigator Window 
The function of the Navigator Window is to provide a quick means of moving around large images. The system displays a 
reduced view of the full size image in the Navigator Window. A green block indicates which area of the image the ROAM 
window displays. 
 
The Toolbar 
The Toolbar contains a set of icons that correspond to items in the top line menus of commonly used functions and add 
additional user functionality. 

 

 Zoom In - Enlarges the displayed image by going to the next zoom factor. 
 

 Zoom Out - Reduces the displayed image by going to the next zoom factor. 
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 Full Size - Displays the image on screen at a ratio of 1 image pixel to 1 screen pixel. 
 

 

 Fit To Screen - Calculates the best scale factor to display the whole image in the Roam Window. 
 

 Rulers - Switches the ruler display On or Off. This function is also accessible from the View menu or by using 
Ctrl / Command + R. 
 

 Show Negative - Switches the image display to Negative or Positive. This function is also accessible from the 
View menu or by using Ctrl / Command + S. 

 

    Custom Color Manager - Allows you to set up a list of custom colors for viewing image separations. This 
function is also accessible from the Tools menu. 
 

  Trap Black - Switches black separations to 50% gray to assist with proofing black traps. 
 
    Map Pages - Allows you to remap the Separation to Page structure of a job. This function is also accessible from 

the Tools menu or by using Ctrl / Command + M. 
 

Scale Box 
The Scale Box allows you to select a scale factor to apply to an image in the Roam Window. 
 
The Menu Bar  
The Menu Bar contains the following Menus and Options. 

The View Menu 

 Show Negative = Ctrl / Command + S 

 Trap Black = Ctrl / Command + T 

 Hand Speed (the speed with which the image moves when panned using the mouse)  

o Normal = Ctrl / Command + 1 
o Medium  = Ctrl / Command + 2 
o Fast = Ctrl / Command + 3 

 Dock Navigator = Ctrl / Command + N 

 Rulers = Ctrl / Command + R 

 Control Box = Ctrl / Command + B 

 Tool Bar 

 Status Bar 
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The Tools Menu 

 Purge Workspace Folder (delete all down-sampled image files to recover disk space). 

 Custom Color Manager (to define ROAM colors for spot color jobs, see details later in this Appendix). 
 

Page List Box 
The Page List Box displays a list of pages and separations for a selected job. 
 
Info Tab 
The Info Tab displays information about the job being viewed. 

Incorrect Separation Mapping 

Although the RIP does a very good job of linking separations with pages, there are some cases where this is not possible. 
The Viewer allows a system whereby this mapping problem can be corrected. 
 
Take the Following as an example: 

 A RIPed job displays in the Viewer with the Colors CMYK listed as 1 color per page e.g. Page 1 – C, Page 2 – M 
etc., as shown below. 
 

Example of Incorrect Color Mapping 

 
   

 The mapping for this job should in fact be Page 1 – CMYK etc., as shown in figure on next page. 
 
 

Correct Color Mapping 
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To correct the job mapping: 

 Select the Map Pages icon from the Toolbar. 
The Viewer will search for a recurring pattern and arrange the separations into pages based on this pattern. In most cases 
this pattern mapping will be successful, but will not work in the case where an extra color represents an individual page. 
To overcome this, the Viewer will prompt you to confirm whether non-recurring colors should be treated as part of the 
recurring pattern or as individual pages.  

Selecting and Deselecting Pages and Separations 

Initially, all of the pages except the first in the Page List box will be collapsed but can be expanded individually to show the 
separations that comprise each page. Separations can be selected or deselected as a page group, or as individual separations. 

 To select all of the separations from a page, double-click on the Page Number in the list. 

 To deselect all the separations click on the Page Number in the list. 

 To select an individual separation click on the Separation Name. 

 To select multiple separations click on a Separation Name, then hold down the Shift or Ctrl / Command keys 
while clicking on the Remaining Separations. 

 To deselect separations hold down the Ctrl / Command key while left-clicking on the Separation Name. Once 
you have selected the separations, select the View button to process the image view. 

Roaming an Image 

After selecting the View button, the Viewer will begin processing the Roam Image. At the same time the Viewer will 
begin producing reduced versions of the image, from which it will create the Navigator View. Although the Navigator 
image may take some time to process you will still be able to Roam around the image and click on the Navigator window. 
 
The Viewer offers three methods of Roaming around an image: 

 Using the scrollbars – There are three ways to roam using the Scrollbars: 
o Clicking on the Arrows at either end of the Scrollbar. 
o Clicking anywhere on the Scrollbar. 
o Dragging the Thumb-tab to any position on the Scrollbar. 

 Using the Hand Tool – To roam using the Hand Tool, click an area of the image in the Roam Window and drag 
the image while holding down the mouse button. 

The Hand Tool has three speed settings selectable from the Hand Speed option under the View menu. The options 
are: 
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o Normal = Ctrl / Command + 1 
o Medium = Ctrl / Command + 2 
o Fast = Ctrl / Command + 3 

 
If the Hand Speed is set to Normal, you can change it temporarily by holding down the Ctrl / Command or the Shift 
key while dragging the image. 
 

 Using the Navigator Window 
Use the Navigator Window for moving quickly from one area of the image to another. To jump to an area of the 
image, just click on the area of the image in the Navigator Window and the Roam Window will update with the 
selected image data. 
 
The Navigator Window is, by default, docked underneath the Page List box in an area that it shares with the Job Info 
box. The Navigator Window may however, be positioned anywhere within the Main Window that you choose. There 
are several ways to Undock the Navigator Window: 
 

 Double click on the Navigator Tab. 

 Drag the Navigator Tab anywhere on the screen. 

 Select the Undock Navigator option from the Tools menu or use Ctrl / Command + N. 
 

The Navigator Window may be Docked using the following methods: 
 

o Double click on the Navigator Windows Title Bar (PC only). 
o Select the Navigator Windows Close Icon. 
o Select the Dock Navigator option from the Tools menu or use Ctrl / Command + N. 

 

 
You can resize the Navigator Image up to a size of 512 x 
512 pixels by dragging the sides or the corner of the 
Navigator window. 

Enlarging and Reducing the Image View 

After selecting the View button, the Viewer may begin creating reduced view images depending on the down-sampling 
option that you chose from the Viewer Properties menu. The process of image reduction is very computer intensive and 
may take some time for large files. The reduction factors available will halve each time - up to the factor where the image 
will fit into the Roam Window, e.g. 100%, 50%, 25%, 12.5% etc. In addition, enlarged Views up to 800% are available 
from the Scale Box. The viewer will write reduced view images to disk to eliminate the need for reprocessing 
unnecessarily. 
 
Selecting a Scale Factor from the Scale Box will update the image view in the Roam Window accordingly. Factors not 
previously processed due to a choice of down-sampling method will display with a red cross next to them. Selecting one of 

these factors will instruct the viewer to begin processing it. Process all previously unprocessed factors by selecting the  
icon on the right of the Scale Box. 
The Viewer stores the Reduce View Images in the disk area defined in the configuration screen. Once the total size of the 
files reaches the space set, the system deletes the oldest files in the folder. 
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 The 50% and 25% roam factors take the longest to down-
sample so it is best to avoid these unless you really need 
them. 

Rotating and Mirroring the Viewed Image 

The Viewer incorporates the ability to rotate viewed images clockwise and counter-clockwise in 90° increments. Select the 

 icon to rotate the image counter-clockwise and the  icon to rotate the image clockwise. Mirror-flip the image by 

selecting the  icon from the Toolbar. 

Switching Separations On or Off during Viewing 

The Viewer allows you to switch separations On or Off while viewing jobs. Separations can be turned On or Off without 
having to reselect the View button unless all of the separations are deselected. To turn a separation On or Off, hold down 
the Ctrl / Command key and click on the Separation Name. 

Black Traps 

The Viewer incorporates the ability to switch the black view from 100% black to 50% black. This feature was introduced 
to allow users to proof traps where the trap consists of black and another color. To switch the black mode, View a job and 

click on the  icon or use Ctrl / Command + T to switch between Trap Black and Normal Black modes. 

Modifying the Roam Color of a Separation 

Change the color used to view a separation by selecting a predefined color or selecting a custom color. To change the 
display color for a particular separation: 

 PC – right-click or double-click on the Separation Name. 

 Mac – double-click on the Separation Name. 

 Select Change Color to change only the selected separation. 

 Select Change All Colors to change the color of all the jobs separations with the same name as the one selected 
 



 

 
 

Appendix B –System backups 
 
It is important to know where the system stores job and workflow data for the purposes of software upgrades and system 
backups.  
 

1. At the root level of the Navigator software installation (in the same folder as the executable file) there are three 
files which contain information about the system configuration : Navigator.jobs, Navigator.actions,  and 
Navigator.wf. After you save a spot color database there will be a fourth file, Navigator.sca, which contains the 
spot color mappings. 

 
2. Files associated with the system, but not contained within the installation folder include the actual job data, 

archived jobs, and the hot folders used for job input.  These are usually at c:/Navigator/Workflows, 
c:/Navigator/Jobs, and c:/Navigator/Archives,  but you may check in the Server to find out for certain. 

 
There is a multi-level backup system in place to allow the Server to automatically recover if these three databases ever 
become corrupted.  
If something happens to cause a file corruption (e.g. a system crash, a power failure) the Server may display a dialog at start 
up which says “Failed to load ‘jobs/workflows/actions’ information, Press OK to continue using backup information or CANCEL to 
quit.”  If at this point you opt to quit the Server, please contact your support provider to investigate the problem with the 
assistance of the log files. If instead you choose to use the backup, your most recent changes (if any) will be lost. 
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Appendix C: Q & A, troubleshooting.  
 
Q. How can I select the M Series plugin? 
A. In the Navigator RIP, device menu (initially this is labelled “Preview”), select “Select 
Device...”. Then, in the “Select Output Device” dialog, select “M Series Printer” and “Select”. 
The Device menu will now be labelled “M Series Printer”. 
In the “M Series Printer” menu, select “Open License Dialog”. Enter the license key and 
“Enable”. 
 
Q. How can I enter a Global password for the M Series plugin? 
A. Passwords are fewer than ten characters long and are numeric. They may be entered when 
first installing Navigator – the installer will prompt for them. In case you need to enter one at 
another time: 
If you have not already done so, follow the instructions in “How can I select the M Series 
plugin?” above. 
In the Navigator RIP, select Navigator->Configure RIP... 
Click “Extras”. 
In the scrollable list of RIP Extras, select “MSeriesPrinter, MSeriesPrinter”. 
Click “Add”, and enter the password in the “Enable Feature” dialog; “OK”. 
 
Q. How can I enter a Xitron license key for the M Series plugin? 
A. License keys are more than ten characters long and are a mix of letters and digits. 
If you have not already done so, follow the instructions in “How can I select the M Series 
plugin?” above. 
In the “M Series Printer” menu, select “Open License Dialog”. Enter the license key and 
“Enable”. 
 
Q. How can I change the M Series plugin settings? 
A. The Navigator installer installs the recommended settings. If you need to change these: 
If you have not already done so, follow the instructions in “How can I select the M Series 
plugin?” above. 
In the “M Series Printer” menu, select “Open Settings Dialog”. Make any necessary changes in 
this dialog, as advised by Xitron Support. 
 
Q. How can I change the M Series plugin configuration? 
A. The Navigator installer installs the recommended configuration. If you need to change it: 

In the Navigator RIP, select Navigator→Page Setup Manager.... 
Select a Page Setup, and “Edit”. In the Edit Page Setup dialog, the selected Device will be “M 
Series Printer”. Select “Configure device...” and make any changes to the plugin configuration, 
as guided by Xitron Support. 
 
Q. The printer is not printing. 
A. Check whether output is disabled in the Navigator RIP’s Output Controller. If it is, the M 
Series Printer icon in the Navigator Client will be labelled “Disabled” as shown below. 

To correct this, in the Navigator RIP, select Output→Output Controller. Uncheck “Disable 
output” as shown below. 
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Q. Some pages are being printed blank, or the printer is feeding a partial sheet of 
paper after my job, possibly resulting in a paper jam. 
A. In the Navigator Client, select the workflow you are using in the left sidebar. Then enter the 
workflow editor by clicking the wrench icon. In the RIP tab, select the configuration “Complex 
art, Photos” as shown below. Click the wrench to exit the workflow editor. 
 
Q. When printing a multi-page job where the pages are not all of the same width, 
some blank pages are printed or the printer feeds a partial sheet of paper after the 
job. 
A. In the Navigator Client, select the workflow you are using in the left sidebar. Then enter the 
workflow editor by clicking the wrench icon. In the “RIP Output” tab, deselect the “Collect 
pages before printing” setting as shown below. Click the wrench to exit the workflow editor. 
 
Q. The customer wishes to run in demo mode. 
A. Install Navigator, selecting “Demonstration” when prompted by the installer. 
 
Q. The customer is running in demo mode but has now purchased a full dongle. 

A. Quit Navigator Server (File→Exit), and in the Start menu select Start→Navigator→Convert to full. 
Then restart Navigator Server. 
 
Q. How does the demo mode / full mode setting work? 
A. There is a text file "harlequinrip.txt" which gives contains the path to the RIP; this is used 
when Navigator Server launches, to start the RIP. 
The location of this file is C:\Program Files\Harlequin\SOAR\Services\5.2r0\Final\allall\ 
all\config\harlequinrip.txt 
The normal RIP is C:\Navigator\Navigator 9.0r1\Xitron.exe. When running in demo mode, a 
variant of this, the "Watermark" RIP is used instead. This is XITRON_WM.exe. 
The Start menu "Convert to full" entry runs a batch file which copies fullharlequinrip.txt over 
harlequinrip.txt. This .bat files contains a preamble which causes the UAC dialog to be 
displayed, so that the operation can be performed with Administrator privileges. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Page 81 

 
  

Appendix D – Apple Public Source License 
 
APPLE PUBLIC SOURCE LICENSE 

                 

Version 1.1 - April 19, 1999 

 

Please read this License carefully before downloading this software. By downloading and using this software, you are agreeing to be 
bound by the terms of this License. If you do not or cannot agree to the terms of this License, please do not download or use the software. 
 
1. General; Definitions. This License applies to any program or other work which Apple Computer, Inc. ("Apple") publicly announces as subject to this Apple Public Source 

License and which contains a notice placed by Apple identifying such program or work as "Original Code" and stating that it is subject to the terms of this Apple Public Source 

License version 1.1 (or subsequent version thereof), as it may be revised from time to time by Apple ("License"). As used in this License: 

 

1.1 "Affected Original Code" means only those specific portions of Original Code that allegedly infringe upon any party's intellectual property rights or are otherwise the subject 

of a claim of infringement. 

 

1.2 "Applicable Patent Rights" mean: (a) in the case where Apple is the grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or assigned to Apple 

and (ii) that cover subject matter contained in the Original Code, but only to the extent necessary to use, reproduce and/or distribute the Original Code without infringement; 

and (b) in the case where You are the grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or assigned to You and (ii) that cover subject matter in 

Your Modifications, taken alone or in combination with Original Code. 

 

1.3 "Covered Code" means the Original Code, Modifications, the combination of Original Code and any Modifications, and/or any respective portions thereof. 

 

1.4 "Deploy" means to use, sublicense or distribute Covered Code other than for Your internal research and development (R&D), and includes without limitation, any and all 

internal use or distribution of Covered Code within Your business or organization except for R&D use, as well as direct or indirect sublicensing or distribution of Covered Code 

by You to any third party in any form or manner. 

 

1.5 "Larger Work" means a work which combines Covered Code or portions thereof with code not governed by the terms of this License.  

 

1.6 "Modifications" mean any addition to, deletion from, and/or change to, the substance and/or structure of Covered Code. When code is released as a series of files, a 

Modification is: (a) any addition to or deletion from the contents of a file containing Covered Code; and/or (b) any new file or other representation of computer program 

statements that contains any part of Covered Code. 

 

1.7 "Original Code" means (a) the Source Code of a program or other work as originally made available by Apple under this License, including the Source Code of any updates or 

upgrades to such programs or works made available by Apple under this License, and that has been expressly identified by Apple as such in the header file(s) of such work; and 

(b) the object code compiled from such Source Code and originally made available by Apple under this License. 

 

1.8 "Source Code" means the human readable form of a program or other work that is suitable for making modifications to it, including all modules it contains, plus any 

associated interface definition files, scripts used to control compilation and installation of an executable (object code). 

 

1.9 "You" or "Your" means an individual or a legal entity exercising rights under this License. For legal entities, "You" or "Your" includes any entity which controls, is controlled 

by, or is under common control with, You, where "control" means (a) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or 

otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or beneficial ownership of such entity. 

 

2. Permitted Uses; Conditions & Restrictions. Subject to the terms and conditions of this License, Apple hereby grants You, effective on the date You accept this License and 

download the Original Code, a world-wide, royalty-free, non- exclusive license, to the extent of Apple's Applicable Patent Rights and copyrights covering the Original Code, to do 

the following: 

 

2.1 You may use, copy, modify and distribute Original Code, with or without Modifications, solely for Your internal research and development, provided that You must in each 

instance: 

 

(a) retain and reproduce in all copies of Original Code the copyright and other proprietary notices and disclaimers of Apple as they appear in the Original Code, and keep intact 

all notices in the Original Code that refer to this License; 

 

(b) include a copy of this License with every copy of Source Code of Covered Code and documentation You distribute, and You may not offer or impose any terms on such Source 

Code that alter or restrict this License or the recipients' rights hereunder, except as permitted under Section 6; and 

 

(c) completely and accurately document all Modifications that you have made and the date of each such Modification, designate the version of the Original Code you used, 

prominently include a file carrying such information with the Modifications, and duplicate the notice in Exhibit A in each file of the Source Code of all such Modifications. 

 

2.2 You may Deploy Covered Code, provided that You must in each instance: 

 

(a) satisfy all the conditions of Section 2.1 with respect to the Source Code of the Covered Code; 

 

(b) make all Your Deployed Modifications publicly available in Source Code form via electronic distribution (e.g. download from a web site) under the terms of this License and 

subject to the license grants set forth in Section 3 below, and any additional terms You may choose to offer under Section 6. You must continue to make the Source Code of Your 

Deployed Modifications available for as long as you Deploy the Covered Code or twelve (12) months from the date of initial Deployment, whichever is longer; 

 

(c) if You Deploy Covered Code containing Modifications made by You, inform others of how to obtain those Modifications by filling out and submitting the information found at 

http://www.apple.com/publicsource/modifications.html, if available; and  

 

(d) if You Deploy Covered Code in object code, executable form only, include a prominent notice, in the code itself as well as in related documentation, stating that Source Code 

of the Covered Code is available under the terms of this License with information on how and where to obtain such Source Code. 

 

3. Your Grants. In consideration of, and as a condition to, the licenses granted to You under this License:  

 

(a) You hereby grant to Apple and all third parties a non-exclusive, royalty-free license, under Your Applicable Patent Rights and other intellectual property rights owned or 

controlled by You, to use, reproduce, modify, distribute and Deploy Your Modifications of the same scope and extent as Apple's licenses under Sections 2.1 and 2.2; and 

 

(b) You hereby grant to Apple and its subsidiaries a non-exclusive,  

worldwide, royalty-free, perpetual and irrevocable license, under Your Applicable Patent Rights and other intellectual property rights owned or controlled by You, to use, 

reproduce, execute, compile, display, perform, modify or have modified (for Apple and/or its subsidiaries), sublicense and distribute Your Modifications, in any form, through 

multiple tiers of distribution. 
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4. Larger Works. You may create a Larger Work by combining Covered Code with other code not governed by the terms of this License and distribute the Larger Work as a 

single product. In each such instance, You must make sure the requirements of this License are fulfilled for the Covered Code or any portion thereof. 

 

5. Limitations on Patent License. Except as expressly stated in Section 2, no other patent rights, express or implied, are granted by Apple herein. Modifications and/or Larger 

Works may require additional patent licenses from Apple which Apple may grant in its sole discretion. 

 

6. Additional Terms. You may choose to offer, and to charge a fee for, warranty, support, indemnity or liability obligations and/or other rights consistent with the scope of the 

license granted herein ("Additional Terms") to one or more recipients of Covered Code. However, You may do so only on Your own behalf and as Your sole responsibility, and not 

on behalf of Apple. You must obtain the recipient's agreement that any such Additional Terms are offered by You alone, and You hereby agree to indemnify, defend and hold 

Apple harmless for any liability incurred by or claims asserted against Apple by reason of any such Additional Terms. 

 

7. Versions of the License. Apple may publish revised and/or new versions of this License from time to time. Each version will be given a distinguishing version number. Once 

Original Code has been published under a particular version of this License, You may continue to use it under the terms of that version. You may also choose to use such 

Original Code under the terms of any subsequent version of this License published by Apple. No one other than Apple has the right to modify the terms applicable to Covered 

Code created under this License. 

 

8. NO WARRANTY OR SUPPORT. The Original Code may contain in whole or in part pre-release, untested, or not fully tested works. The Original Code may contain errors 

that could cause failures or loss of data, and may be incomplete or contain inaccuracies. You expressly acknowledge and agree that use of the Original Code, or any portion 

thereof, is at Your sole and entire risk. THE ORIGINAL CODE IS PROVIDED "AS IS" AND WITHOUT WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE 

AND APPLE'S LICENSOR(S) (FOR THE PURPOSES OF SECTIONS 8 AND 9, APPLE AND APPLE'S LICENSOR(S) ARE OLLECTIVELY REFERRED TO AS "APPLE") 

EXPRESSLY DISCLAIM ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

AND/OR CONDITIONS OF MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD 

PARTY RIGHTS. APPLE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE ORIGINAL CODE WILL MEET YOUR REQUIREMENTS, OR THAT THE 

OPERATION OF  

THE ORIGINAL CODE WILL BE UNINTERRUPTED OR ERROR- FREE, OR THAT DEFECTS IN THE ORIGINAL CODE WILL BE CORRECTED. NO ORAL OR 

WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE OR AN APPLE AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY 

INCREASE THE SCOPE OF THIS WARRANTY. You acknowledge that the Original Code is not intended for use in the operation of nuclear facilities, aircraft navigation, 

communication systems, or air traffic control machines in which case the failure of the Original Code could lead to death, personal injury, or severe physical or environmental 

damage. 

 

9. Liability. 

 

9.1 Infringement. If any portion of, or functionality implemented by, the Original Code becomes the subject of a claim of infringement, Apple may, at its option: (a) attempt to 

procure the rights necessary for Apple and You to continue using the Affected Original Code; (b) modify the Affected Original Code so that it is no longer infringing; or (c) 

suspend Your rights to use, reproduce, modify, sublicense and distribute the Affected Original Code until a final determination of the claim is made by a court or governmental 

administrative agency of competent jurisdiction and Apple lifts the suspension as set forth below. Such suspension of rights will be effective immediately upon Apple's posting 

of a notice to such effect on the Apple web site that is used for implementation of this License. Upon such final determination being made, if Apple is legally able, without the 

payment of a fee or royalty, to resume use, reproduction, modification, sublicensing and distribution of the Affected Original Code, Apple will lift the suspension of rights to the 

Affected Original Code by posting a notice to such effect on the Apple web site that is used for implementation of this License. If Apple suspends Your rights to Affected Original 

Code, nothing in this License shall be construed to restrict You, at Your option and subject to applicable law, from replacing the Affected Original Code with non-infringing code 

or independently negotiating for necessary rights from such third party. 

 

9.2 LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES SHALL APPLE BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE OR YOUR USE OR INABILITY TO USE THE ORIGINAL CODE, OR ANY PORTION THEREOF, 

WHETHER UNDER A THEORY OF CONTRACT, WARRANTY, TORT (INCLUDING NEGLIGENCE), PRODUCTS LIABILITY  

OR OTHERWISE, EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING THE FAILURE OF ESSENTIAL 

PURPOSE OF ANY REMEDY. In no event shall Apple's total liability to You for all damages under this License exceed the amount of fifty dollars ($50.00). 

 

10. Trademarks. This License does not grant any rights to use the  

trademarks or trade names "Apple", "Apple Computer", "Mac OS X", "Mac OS X Server" or any other trademarks or trade names belonging to Apple (collectively "Apple Marks") 

and no Apple Marks may be used to endorse or promote products derived from the Original Code other than as permitted by and in strict compliance at all times with Apple's 

third party trademark usage guidelines which are posted at http://www.apple.com/legal/guidelinesfor3rdparties.html. 

 

11. Ownership. Apple retains all rights, title and interest in and to  

the Original Code and any Modifications made by or on behalf of Apple ("Apple Modifications"), and such Apple Modifications will not be automatically subject to this License. 

Apple may, at its sole discretion, choose to license such Apple Modifications under this License, or on different terms from those contained in this License or may choose not to 

license them at all. Apple's development, use,  

reproduction, modification, sublicensing and distribution of Covered  

Code will not be subject to this License. 

 

12. Termination. 

 

12.1 Termination. This License and the rights granted hereunder will terminate: 

 

(a) automatically without notice from Apple if You fail to comply with any term(s) of this License and fail to cure such breach within 30 days of becoming aware of such breach; 

(b) immediately in the event of the circumstances described in Section 13.5(b); or (c) automatically without notice from Apple if You, at any time during the term of this License, 

commence an action for patent infringement against Apple. 

 

12.2 Effect of Termination. Upon termination, You agree to immediately stop any further use, reproduction, modification, sublicensing and distribution of the Covered Code and 

to destroy all copies of the Covered Code that are in your possession or control. All sublicenses to the Covered Code which have been properly granted prior to termination shall 

survive any termination of this License. Provisions which, by their nature, should remain in effect beyond the  

termination of this License shall survive, including but not limited  

to Sections 3, 5, 8, 9, 10, 11, 12.2 and 13. Neither party will be  

liable to the other for compensation, indemnity or damages of any sort solely as a result of terminating this License in accordance with its terms, and termination of this 

License will be without prejudice to any other right or remedy of either party. 

 

13. Miscellaneous. 

 

13.1 Government End Users. The Covered Code is a "commercial item" as defined in FAR 2.101. Government software and technical data rights in the Covered Code include 

only those rights customarily provided to the public as defined in this License. This customary commercial license in technical data and software is provided in accordance with 

FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for Department of Defense purchases, DFAR 252.227-7015 (Technical Data -- Commercial Items) and 

227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation). Accordingly, all U.S. Government End Users acquire Covered Code with only 

those rights set forth herein. 

 

13.2 Relationship of Parties. This License will not be construed as creating an agency, partnership, joint venture or any other form of legal association between You and Apple, 

and You will not represent to the contrary, whether expressly, by implication, appearance or otherwise. 
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13.3 Independent Development. Nothing in this License will impair Apple's right to acquire, license, develop, have others develop for it, market and/or distribute technology or 

products that perform the same or similar functions as, or otherwise compete with, Modifications, Larger Works, technology or products that You may develop, produce, market 

or distribute.  

 

13.4 Waiver; Construction. Failure by Apple to enforce any provision of this License will not be deemed a waiver of future enforcement of that or any other provision. Any law or 

regulation which provides that the language of a contract shall be construed against the drafter will not apply to this License. 

 

13.5 Severability. (a) If for any reason a court of competent jurisdiction finds any provision of this License, or portion thereof, to be unenforceable, that provision of the License 

will be enforced to the maximum extent permissible so as to effect the economic benefits and intent of the parties, and the remainder of this License will continue in full force 

and effect. (b) Notwithstanding the foregoing, if applicable law prohibits or restricts You from fully and/or specifically complying with Sections 2 and/or 3 or prevents the 

enforceability of either of those Sections, this License will immediately terminate and You must immediately discontinue any use of the Covered Code and destroy all copies of 

it that are in your  

possession or control. 

 

13.6 Dispute Resolution. Any litigation or other dispute resolution between You and Apple relating to this License shall take place in the Northern District of California, and 

You and Apple hereby consent to the personal jurisdiction of, and venue in, the state and federal courts within that District with respect to this License. The application of the 

United Nations Convention on Contracts for the  

International Sale of Goods is expressly excluded. 

 

13.7 Entire Agreement; Governing Law. This License constitutes the entire agreement between the parties with respect to the subject matter hereof. This License shall be 

governed by the laws of the United States and the State of California, except that body of California law concerning conflicts of law. 

 

Where You are located in the province of Quebec, Canada, the following clause applies: The parties hereby confirm that they have requested that this License and all related 

documents be drafted in English. Les parties ont exige que le present contrat et tous les documents connexes soient rediges en anglais. 

 

EXHIBIT A. 

 

"Portions Copyright (c) 1999 Apple Computer, Inc. All Rights Reserved. This file contains Original Code and/or Modifications of Original Code as defined in and that are subject 

to the Apple Public Source License Version 1.1 (the "License"). You may not use this file except in compliance with the License. Please obtain a copy of the License at 

http://www.apple.com/publicsource and read it before using this file. 

 

The Original Code and all software distributed under the License are  

distributed on an "AS IS" basis, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND APPLE HEREBY DISCLAIMS ALL SUCH WARRANTIES, 

INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON- NFRINGEMENT. Please see 

the License for the specific language governing rights and limitations under the License." 

 

 


